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EETEEh Notes on the Operating Manual

1 Notes on the Operating Manual

This operating manual provides all the necessary information on the topics
specified in the Table of Contents.

It instructs the target group(s) defined for the respective areas on the safe and
purpose-conformant use. Familiarity with the relevant chapter is a precondition for
the safe and purpose-conformant use of the machine.

This technical documentation is a reference work and learning guide. The
individual chapters are complete by themselves.

This operating manual does not contain any repair instructions. In case of any
faults or repairs being required, please contact your supplier or directly get in touch
with

Retsch GmbH http://www.retsch.com/

Please also follow the instructions in the operating manual for your planetary
ball mill.

This document only has instructions for the use of the PM GrindControl. Safe
handling of the Planetary Ball Mill is a precondition for the use of the PM
GrindControl.

Copyright

Disclosure or reproduction of this documentation, use and disclosure of its contents
are only permitted with the express permission of Retsch GmbH.

Infringements will result in damage compensation liability.
Changes

Subject to technical changes.


http://www.retsch.com/
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2 Confirmation

| have read and taken note of the contents of the
Chapters on Notes on the Operating Manual, Safety
Instructions, Warnings and Summary of all Safety
Instructions.

Signature of owner/managing operator

Signature of service technician
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2.1 Method of Operation

> The wireless grinding jar cover cannot be used in the PM 200.

Comply with the operating instructions for your planetary ball mill too.

This document only has instructions for the use of the PM GrindControl. Safe
handling of the planetary ball mill is a precondition for the use of the PM
GrindControl.

This wireless grinding jar cover and the PM GrindControl software serve to
continuously acquire the parameters pressure and temperature in a grinding jar.
The measured values read by the sensors located in the grinding jar cover are
transmitted wirelessly to a receiver system in the PC.

The temperature sensor is thermally separate from the grinding jar cover and
measures only the gas temperature in the grinding chamber. As a result, even
rapid or slight changes in temperature are registered.

The transmitted data is displayed and stored in the software. For every

measurement, the values measured are stored in a file (dat-file) and are then
available for extensive evaluations.

The wireless grinding jar cover permits the use of the system in the PM 100 and
PM400.

Essentially, the following steps are necessary for using the PM GrindControl
software to monitor the temperature and the pressure in the grinding jar:

1. Definition of a measurement task
2. Integration of the measurement systems involved
3. Execution of the measurement

4. Evaluation of the measurement data

The evaluation can be conducted at a separate time from the measurement, i.e.
the raw data can be inputted again later and evaluated. The raw data contains all
the settings and protocol inputs stored in the measurement task.
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3 Technical Data

3.1 Operating Conditions

3141

3.1.5

Temperature Range

The temperature range is determined by the max. permissible temperature inside
the wireless grinding jar cover (measurement electronics) of 70°C.

An additional sensor measures the temperature of the measurement unit inside the
wireless grinding jar cover. On exceeding 70°C, a warning is outputted on the
screen.

Monitor the temperature of the measurement unit inside the wireless grinding
jar cover at regular intervals to avoid damage to the measurement
electronics.

When you move the mouse cursor over the text box of the grinding jar, the
momentary temperature inside the wireless jar cover is displayed as a small tool tip
beside the mouse cursor. (See image: Temperature inside the wireless grinding jar
cover)

PM Grind Control EM2

Fig. 1: Temperature inside the wireless grinding jar cover

Measurement Resolution of the Temperature Measurement : 0.1 °C

Accuracy of the Temperature Measurement: +1%

Pressure ranges

Operating Time

- Maximum permissible pressure range
inside the grinding beaker: up to 5.0 bar (500 kPa)
Screw the clamping screws on the clamping ring tight!

Maximum internal pressures of 5.0 bar are only permissible where there is
sufficient initial tension on the clamping ring.

Rotational speed range

Rotational speed range: corresponds to the maximum rotational speeds of the PM
100 or PM 400 respectively

Transmitter range

Transmitter range: approx. 15 m in buildings
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Operating time with full battery charge:
- highly dynamic measuring rate (200 Hz) - 40h

- long-time measuring rate (0.2 Hz) - 80h
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3.2 Transport and Storage

3.2.1 Packaging

The packaging has been adapted to the mode of transport. It complies with the
generally applicable packaging guidelines.

Please retain the packaging for the duration of the warranty period because
returning in unsuitable packaging in the event of a complaint can jeopardize your
warranty claims.

3.2.2 Transport

Do not subject the PM GrindControl to impacts, jolts or vibrations during
transportation as this can damage the electronic and mechanical components.

3.2.3 Temperature Fluctuations

Where temperature fluctuates greatly (during shipment by air, for instance), protect
the PM GrindControl from condensation. The electronic components could
otherwise be damaged.

3.3 Care Instructions and Storage

The two cover baseplates are made of hardened stainless steel (1.4034).

Hardened steel has a lower chromium content and so it does not form any oxide
protective layer. Therefore, it distinguishes itself not by its corrosion resistance, but
by its greater hardness.

We therefore use a special oil to protect these grinding tools. Please remove the oil
before using it the first time; water and detergent are enough for this purpose.
Please dry the grinding tool well.

After the grinding operations, the grinding tools must be cleaned in as dry a state
as possible. However, if they are extremely dirty, they can be cleaned with a damp
cloth and some household detergent. It is important to ensure sufficient drying.

If the grinding tools are to be stored for a long time, we recommend the use of a
corrosion protection oil. If corrosion occurs nonetheless, it can be removed with
household scouring agents.

Also recommendable for long-time storage is to store the parts in the
accompanying VCE bags. (blue plastic bags).

Caution — Damage to electronic components!
Do not clean the radio grinding jar cover under running water.

10
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The First Start

4 The First Start

4.1 Complete Program Sequence up to First Measurement

The following sequence presents only the steps necessary for the first activation
and the test to see if the wireless grinding jar cover is functioning perfectly.

Read all chapters in this operating manual!
This description of the first activation of a wireless grinding jar cover does not

replace the need to read the operating instructions. Read the other chapters in this
manual too.

Please also read and observe the operating instructions for your planetary ball mill!
1. First, charge the three storage batteries completely using the charging

adapter in the accompanying charger. Read the chapter on OPERATING
INSTRUCTIONS POWERLINE 5 LCD beforehand

2. Follow the instructions in the Software Installation chapter and install the
USB driver for the ZigBee USB — wireless unit, the USB driver for the TG-
ETRXn USB port and the PM GrindControl software.

3. Start the PM GrindControl software.

Do not pull the Telegesis (ZigBee) USB Stick out of the USB port as long as
the PM GrindControl software is active.

If the PM GrindControl software does not find the USB wireless unit (Telegesis),
you must connect the USB-stick manually once again. This requires the following
steps:

. Confirm the warning with OK.
(the PM GrindControl software starts)
. In program, PM GrindControl prodram select
Settings > Options > .
. Click on the Connect Again button
4. Insert the 3 fully charged batteries 1 into the wireless grinding jar.

The status indicator lamp starts to flash red and then glows a steady red.
Execute the following command in the PM GrindControl software::

A
i

5. Menu File & Measurement task, new ==

6. Assign a new name to the first measurement task and save the file to a local
drive (e.g. C:\).

The measurement tasks must be saved to a local drive.

The Configure Measurement Systems program window is displayed.

7. Go to the MAC address filed and enter your grinding jar's MAC address
number sequence.

11
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Configure measuring systems |

MAC address:
ti?‘@ ég Next > | Cancel |
IDDSDE‘I 0000003385 | T

! MName | Assignment | Serial number | Battery voltage [V] | Signal strength [dBm] |

Fig. 2: Enter into the MAC address field.

You will find the MAC address on the cover page of your operating manual:

Retsch GmbH
EE‘E Eh Rheinische StraBe 36

42781 Haan, Germany

www.retsch.com

Type PM Grind Control 500ml
Produced 2008

Part No. S

il -7

Fig. 3: MAC address

After 15 minutes without assignment to a measurement task, the wireless
grinding jar cover switches off. If the status indicator lamp is not glowing red
any longer, take out one of the batteries and then put it back in again.

8. Click on the button Add measurement system..
Once the system corresponding to the MAC address has been found,
9. confirm with the OK button.

The status indicator lamp now glows green.

The System Information program window is displayed.

10. In the Name field, enter a name for the wireless grinding jar cover.

Parameter <
Name: IRetsc:h 1
Assign: I

Fig. 4: Name field
11.  After clicking on the Accepft button,
12.  you can end the procedure by clicking on the Close button.

The changed name is the name that is stored in the measurement system. On
connecting the next time, the measurement system will identify itself with this new
name.

13. Double-click to open the active system and click on the Assign field

System Information
Parameter (\
Name: \ jl |Retsc:h 1
Assign: {1

Fig. 5: Assign active system to the measurement.

12
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This adds the wireless grinding jar cover to the current measurement task as one
of the four possible measurement systems.

14.  After clicking on the Accept button, you can end the procedure by clicking
on the Close button.

15.  Now, click on the Continue button in the Assign measurement systems
program window.

In the Measurement Task window, you can input a remark for the measurement
task.

16. Click on the Continue button.

17.  In the measurement file window, input a name for the first measurement of
the measurement task.

In the measurement file window, you can also input the operator and a remark for
the measurement.

18.  You can end the creation of the measurement task with the Finish button.

19. In the program window, in the Run Settings area, click on the protocol
inputs button.

% auto 30s /; et
' auto min
" All Data

Comment: Name

|Retsch 1

Serial number >
|Fm

Protocol inputs —{

190 200

_ Measuring rate
Machine: l— " Highly dynamic
Material: I ¢ Dynamic
el I & Normal

r :
Grinding time: | tenine
Interval: I
Pause: I

Grinding jar size: I—
MNumber of grinding media:: l—
Grinding media designation: [
Gas atmosphere: l—

T
Fig. 6: Protocol Inputs

20. After making these inputs, you can store the data with the Accept button
21.  With the Close button, you are taken back to the program window.
22. Start the measurement with the Start button.

13
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()f=]

Fig. 7: Start - Pause - Stop

14
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5 Software

5.1 System Requirements

. Windows XP SP Il and Windows Vista
. USB port (Version 1.1 or 2.0)

. The user must have local administrator rights.

. All energy saving functions on the PC system must be turned off.
. No screen saver with password input may be turned on.

. No programs that consume additional resources may be active.

. Use a CPU with at least two cores (dual-core CPU)

5.2 Software Installations

5.2.1 Installing the USB Drivers

Do not pull the Telegesis (ZigBee) USB Stick out of the USB port as long as
the PM GrindControl software is active.

Before you can install the software for PM GrindControl, the driver software of the
ZigBee USB wireless unit must be installed:

. Insert the installation CD included in the scope of supply into the CD ROM
drive in your PC.

. Insert the ZigBee USB wireless unit (Telegesis) into a free USB port on
your PC. And follow the installation instructions

1. “Wizard for searching for new hardware”
. Select "Yes, only this time"
2. “Wizard for searching for new hardware” window

. Select "Automatically install software (recommended)" and click on
<Continue>.

3. "Hardware Installation" window

. In the following windows warning, select "Continue installation"

After the software for the Telegesis USB device has been installed, the
> installation for the TG-ETRXn USB port follows automatically.

1. "Wizard for searching for new hardware" window
. Select "Yes, only this time"
2. "Wizard for searching for new hardware" window

. Select "Automatically install software (recommended)" and click on
<Continue>

3. “Hardware Installation” window

. At the following Windows safety instruction select "Continue installation”

15
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5.2.2

Installation of the PM GrindControl Software

>

5.3 File System

5.3.1

16

>

File Endings

. Start the setup.exe from the accompanying installation-CD-ROM and follow
the instructions that appear.

. Check with Windows Update whether important updates for .Net Framework
are available.

. Start the PM GrindControl software.

If you followed the instructions from chapter "The first Start", you can
proceed to point 4 of the corresponding chapter.

For each new measurement task create a new folder with the standard Windows
functions. This folder may be located only on the local computer system and not in
the network.

When a new measurement task is created, a new folder will be set up
automatically for the measurement data and a measurement file (.afg) created.
This file contains information on the measurement task, the measurement systems
involved and a list of the measurements carried out.

For every new measurement, the software generates a new folder (in the
measurement task folder). This folder has the name of the current measurement
and is numbered serially by the software. It contains the data record of the
measurement systems involved. Once a file exceeds a certain size, it is divided.

Reading in data after a measurement

The measurement data in the PM GrindControl software can only be viewed if the
originally created data structure has not been changed.

The file for the measurement task (.afg) and its folder must be stored in the same
folder.

The PM GrindControl software uses the following file endings:

File ending Meaning

.mms measurement system file

vl temperature and voltage logfile
.dat (measurement) data

These files are in the measurement task folder and may not be deleted or
processed.
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Folder:
c:\Measurement files

File:
Measurement_task_Afa
File:
Measurement_task_B.5F

File:
Measurement_task...'.}f;

to other data carriers.

The folder for the measurement files must be on
a local data medium. It is not possible to move it

Folder:
—— Measurement task
( Folder: ‘
Measurement
File:
|_ Measurement_1.data
File:

Measurement_1_1.dat

[ Folder:
-~ Measurement_2

File:

| z] Measurement_2.dat
I File:

Measurement_2_1.da

Measurement_n_1.da

LA B}
{ Folder:
L - Measurement_n
File:
ﬁ] Measurement_n.dat
| - File:
v

Once the file reaches a
certain size — e.g. during
continuous measurements -
the measurement data file is
split.

Folder:
* Measurement_task_B

|

Folder:
_— Measurement_task...

>

Fig. 8: File Structure

17
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5.4 Software Interface

The program window for the PM GrindControl software breaks down into the
following function areas:

Fle View Settngs Help

ENT==RE=E

Retsch 1 = e T o e
2 lle—EH o208 o—= 8

Fig. 9: Function areas for the PM GrindControl software

1 Menu and menu bar

2 Measurement Start - Pause - Stop

3 Diagram (graph box)

4 View menu to show the diagram

5 Protocol inputs and measurement rate setting

6 Status bar for the measurement systems

=cH= 7

5.5 Menu and Menu Bar

Fig. 11: Menu bar

18
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5.5.1 Menu File - Measurement task, new

Use this command to create a new empty measurement task and at the same time
end the current measurement task.

Using standard Windows functions, create a new folder for each new measurement
task. This folder may only be stored on the local computer system and not in the
network .

When creating a new measurement task, a new folder is created automatically for
the measurement data and a measurement file (.afg). This file contains information
on the measurement task, the measurement systems involved and a list of the
measurements carried out.

For each new measurement, the software generates a new folder in the
measurement task folder. This folder has the name of the current measurement
and is numbered consecutively by the software. It contains the data record of the
participating measurement systems. Once a file exceeds a certain size, it is
divided.

Alternatively, you can also use the following button.

I,
e

[2== ]
Fig. 12: Button Measurement task, new
5.5.1.1 Steps for Creating a New Measurement Task

0. Once you click on the symbol or the command, the “Configure measurement
task” window appears. Assign a new name to the first measurement task
and save the file to a local drive (e.g. C:\).

’ The measurement tasks must be saved to a local drive.

The Configure Measuring Systems program window appears. If you wish to add a
new measuring system, follow steps 1. to 6.

1. Enter your grinding jar's MAC address number sequence into the MAC
address field in the Configure Measuring Systems program window.

Configure measuring systems

MAC address: B
g@ ﬁ Next > | Cancel |
IDDSDE'I 0000003385 e -

| MName | Assignment | Serial number | Battery voltage [W] | Signal strength [dBm] |
I

Fig. 13: Enter into the MAC address field

You will find the MAC address on the cover page of your operating manual:

Retsch GmbH
EETE Eh Rheinische Strafie 36
42781 Haan, Germany
www.retsch.com
Type PM Grind Control 500ml
Produced 2008
Part No.

il -7

MAC o~ -

Fig. 14: MAC Address

19
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>

After 15 minutes without assignment to a measurement task, the wireless
grinding jar cover switches off. If the status indicator lamp is not glowing red
any longer, take out one of the batteries and then put it back in again.

L
2. Click on the Add measurement system J button.

Once the system that corresponds to the MAC address has been found,
3. confirm with the OK button.
The status indicator lamp now glows green.

The “System Information” program window is displayed.

4. In the Name field, enter a name for the wireless grinding jar cover.
Parameter (
Name: IF{etsch 1
Assign:

Fig. 15: Name field
5. After clicking on the Accept button,
6. you can end the procedure by clicking on the Close button.

The changed name is the name that is stored in the measurement system. On
connecting the next time, the measurement system will identify itself with this new
name.

7. If one or more measuring systems are logged in with the MAC address
already, these are displayed in the “Configure Measuring Systems” program
window:

Inactive Systems:
The measuring system is switched off or is outside the transmitter range.
Active Systems:

The measuring system can be added to the measurement task.

If you switch on a measuring system at a later point in time or bring it into the
transmitter range, this is not automatically displayed in the list of active systems.

With the Search for Known Measuring Systems button you can start a new
search for measuring systems.

2

Fig. 10: Search for Known Measuring Systems button

8. Open the active system by double-clicking on it and then click on the Assign
field.
System Information

Parameter /\
Name: & IReTsch 1
Assign: | |



[Hetsch’

Software

Fig. 11: Assign the active system to the measurement

This adds the wireless grinding jar cover as one of the four possible measurement
systems for the current measurement task.

9. After clicking on the Accept button, you can end the procedure by clicking on
the Close button.

10. Now click on the Continue button in the Configure Measuring Systems
program window.

In the “Measurement Task” window, you can input a remark for the measurement
task.

11. Click on the Continue button.

12. in the “Measurement File” a name must be inputted for the first
measurement of the measurement task.

You can also input the operator and a remark for the measurement in the
“Measurement File” window.

13. You can end the creation of the measurement task by clicking on the Finish
button.

5.5.1.2 Menu File - Open Measurement Task

Use this command to open an existing measurement task. Another
measurement will be added.

Alternatively, you can also use the following button.

Fig. 12: Add New Measurement File to a Measurement Task button
Once you click on this symbol or the command, the “Open” window opens.

1. Select the measurement task to which you wish to add another
measurement and click on Open.

The "Search for Assigned Measuring Systems" opens and you can see the
list of the inactive systems.

If you switch on a measuring system at a later point in time or bring it into the
transmitter range, this is not automatically displayed in the list of active systems.

You can use the Search for Known Measuring Systems button to start a new
search for measuring systems.

2

Fig. 13: “Search for Known Measuring Systems” button

If you double-click on the active measuring systems, information on these systems
will be displayed.

2. Click on the Continue button.

The measurement task window opens and displays which measuring
systems are involved in the new measurement.

3. Click on the Continue button.

The Measurement File window opens.

21
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4. Select a file in the "Existing Measurement Files” list. This accepts the
protocol inputs from the corresponding measurement.

5. Enter a tick into the Add Counter checkbox. This inserts a counter after
the file name or updates an existing counter.

6. Click on the Finish button.
5.5.1.3 Menu File - Close Measurement Task

This command closes and saves an opened and an active measurement task
and the active measurement.

5.5.1.4 Menu File - Open Measurement Data

Viewing the RunFiles in a measurement task
Reading in data after a measurement

’ The measurement data in the PM GrindControl software can only be viewed if the
originally created data structure has not been changed.

The measurement task file (.afg) and its folder must be saved in the same folder.

Alternatively, you can also use the following button.

Fig. 20: Show Existing Measurement Data button
5.5.1.5 Menu File - Export Measurement Data
Exports the data in an opened RunFile into an ASCII file.

Alternatively, you can also use the following button.

Fig. 21: Export measuring data button
5.5.1.6 Menu File - End

Use this command to end the program.

Any information that has not been stored already is saved now and all program
processes are ended.

End Program

> The program can only be closed with the Menu File > End command. For that
reason the program does not have the customary window symbols used in
Windows.

5.5.2 Menu View

In the View menu item you will find the following entries:

. diagram
. measurement setting
. status bar
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Fig. 22: PM GrindControl Software function areas

5.5.2.1 Menu View - Diagram

Activates or deactivates the display of the measurement diagram.

Item numbers [3]+[4] in the "Function Areas of the PM GrindControl software"
figure.

Alternatively, you can also use the following button.

=1

Fig. 23: Show Diagram button
5.5.2.2 Menu View - Measurement Settings

Activates or deactivates the display of the measurement settings and
measurement Start - Pause - Stop.

Item numbers [2]+[5] in the "Function Areas of the PM GrindControl Software"”
figure.

Alternatively, you can also use the following buttons.

=

Fig. 24: Show diagram button
5.5.2.3 Menu View - Status Bar

Activates or deactivates the status bar display.

Item number [6] in the "Function Areas of the PM GrindControl Software"
figure.

Alternatively, you can also use the following button.

o

Fig. 23: Status Bar Display button
5.5.2.4 Menu View - Tool bar

Activates or deactivates the display of the tool bar.
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Item number [1] in the "Function Areas of the PM GrindControl Software"
figure.

5.5.3 Menu Settings

In the Settings menu item you will find the following entries:
. Measuring Systems Management

. Options...
5.5.3.1 Menu Settings - Measuring Systems Management

Opens the “Measuring Systems Management” window.
5.5.3.2 Menu Settings - Options

Opens the “Options” window.
5.5.4 Menu Help

You will find the following entries in the Help menu item:
. on the PM GrindControl

. User guide

5.5.5 Menu View

In the View menu item you will find the following entries:

. diagram

. measurement setting
. status bar

. tool bar

24
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Protocol inputs

40

—p Comment:

42

41

— Machine:

————— Material:

43

44

— Speed:

————p Girinding time:

45

46

— Interval:

—————p Faus=e:

47

48

[——————— Grinding jar size:

49

50

[—— Number of grinding media::

[—————— Grinding media designation;

51

|
|
|
|
|
|
» [ Reversing operation
|
|
|
|

| Gas atmosphere:

Close | Acoept

Fig. 14: Program window for protocol inputs

The protocol details are saved in the .afg file.

You can save the following parameters:
40 Comments

41 Material

42 Machine

43 Speed

44 Grinding time

45 Interval

46 Pause

47 Reversing operation

48 Grinding jar size

49 Number of grinding media
50 Grinding media designation

51 Gas atmosphere
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5.6 Status Bar for the Measuring Systems

30 (| 31 || 32 35
Retsch 1 v v Retsch 2 e v

258 °C 244 °C e [ -
é 100.0 kPa é 988 kPa é [~ kPa é [
33 || 34

Fig. 15: Status Bar for the Measuring Systems

30 Name of the measuring system

31 Temperature inside the grinding jar

32 Battery level status

33 Transmission status of the measuring system
34 Pressure inside the grinding jar

35 Empty fields for more measuring systems

When you move the mouse cursor over the text box of the grinding jar, the current
temperature inside the wireless jar cover is displayed as a tool tip. (see image)

When you move the mouse cursor over the battery symbol the voltage in the
measuring system is displayed as a tool tip (see image).

PM Grind Conirol EM2
&) s

Fig. 16: Temperature inside the wireless grinding jar cover

5.7 Explanation of the Icons and Symbols
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Fig. 29: Program menu item symbols

Fig. 30: Create new measurement task

3§

Fig. 31: Add new measurement file to a measurement task.
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Fig. 33: Export measurement data

=

Fig. 34: Display diagram

T

ig. 35: Display measurement settings

Fig. 36: Display status bar

mJ

L

Fig. 37: Measuring systems management
5.8 Measuring Rates

Highly Dynamic Measuring Rate (200 Hz) - 40h
Long-time Measuring Rate (0.2 Hz) - 80h

Consider which measuring rate is best for your application. If possible, select a low
measuring rate (normal). This reduces the volume of data.
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6 Wireless Grinding Jar Cover

6.1 Wireless Grinding Jar Cover Components

28

1
2
3
1
4

Fig. 38: Wireless grinding jar cover, top view

+ Battery

» Gassing valves / or cover caps
» Status indicator lamp

Wireless antenna

» Cover plate

* MAC wireless address

N o a bk wDd =
L]

* Grinding jar cover

14

25
20

14

Fig. 39: Wireless grinding jar cover, bottom view
14 Opening for the deaeration valves (cover baseplate with venting holes)
25 Temperature sensor

20 Air ducts for measuring pressure
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6.2 Inserting the Batteries

Fig. 17: Inserting the batteries

> Batteries may not be disposed of with the household trash. Bring the used batteries
to your dealer or to the battery collection point.

6.3 Turning Off the GrindControl

- Remove one of the storage batteries to switch the PM GrindControl off.

- If necessary, insert the battery the other way around to store it. This keeps
the PM GrindControl turned off.

Fig. 18: Turning off the PM GrindControl

6.4 LED Display on the Wireless Grinding jar Cover

6.4.1 Status indications

- Red (switched on and initialized)
- Green (connected)

- Red flashing (initializing flickering)
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- Green flashing (measurement was started
and measurement values are being transmitted)

6.5 Cleaning the Air Duct in the Pressure Sensor

The air ducts (20) in the pressure sensor can be cleaned with a vacuum cleaner
too if they get dirty.

Fig. 19: Air ducts

6.6 Gassing Function
To enable the PM GrindControl to be used for grinding in a controlled atmosphere
also, the kit contains a cover baseplate with venting holes for the gassing function
(centring plate with venting holes).

> When using the gassing function, make sure the gassing channels are free.

The venting holes can also be cleaned with a vacuum cleaner too if they get dirty.
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Wireless Grinding Jar Cover

6.7 Exchanging the Cover Baseplate

N

;

:

Fig. 43: Assembly of the cover baseplate and the de-aeration parts

The following steps are required to replace the pre-assembled standard cover
baseplate (centring plate standard) with the cover baseplate which has venting
holes for the gassing function (centring plate with ventilation holes):

Required tools:

13-mm open-jaw wrench
Hexagon socket screw key 2.5 mm
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Unscrew the antenna (4).
Remove the two black caps from the venting holes (9).

Remove the three screws (13) on the pre-assembled standard cover
baseplate and lift the plate up from the cover housing.

Place the cover baseplate with the venting holes (12) in front of you with the
recess for the filter fleece (8) pointing upwards.

. Caution! When inserting the two de-aerating tubes (14), the surface
with which the tubes are fitted (flat) (10) must point downwards. After
tightening, this flat fits on the cover baseplate.

14

S ~ 7] 10

Fig. 44: Position of the de-aerating tubes

Screw the two de-aerating tubes (14), as described, from the top downwards
into the cover baseplate (12) and tighten it with a 13-mm open-jaw wrench.

Before assembly, check the state and the correct position of the seals and
the filter fleece.

Now, insert the cover baseplate with the de-aerating tubes mounted on it into
the cover housing; when doing so, pay attention to the position of the filter
fleece (11).

Next, tighten the cover baseplate with the three screws (13).

Screw the two de-aerating valves (2) into the venting holes (9) and tighten
them with a 13-mm open-jaw wrench.

Screw the antenna (4) onto the grinding jar cover.

6.8 Changing the Filter Fleece

Depending on the application and the period of use, it may be necessary to replace
the filter fleece that is located in the grinding jar cover.

Replace the filter fleece if it is very dirty.

6.9 Replacing the Filter Fleece When Using the Standard Cover Baseplate

Tools required:
Hexagon socket screw key 2.5 mm

32

Unscrew the antenna (4).

Remove the three screws (13), on the pre-assembled standard cover
baseplate and lift the plate up from the cover housing.
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Wireless Grinding Jar Cover

Fig. 13: Replacing the filter fleece

Replace the filter fleece.

Before assembly, check the state and the correct position of the seals and
the filter fleece.

Now, insert the cover baseplate back in the cover housing; when doing so,
pay attention to the position of the filter fleece (11).

Next, tighten the cover baseplate with the three screws (13).

Screw the antenna (4) onto the grinding jar cover. Tauschen Sie das
Filtervlies aus.

6.10 Replacing the Filter Fleece When Using the Gassing Function

Tools required:

13-mm open-jaw wrench
Hexagon socket screw key 2.5 mm:

Unscrew the antenna (4).
Remove the two de-aeration valves (2), using a 13-mm open-jaw wrench.

Remove the three screws (13) on the pre-assembled standard cover
baseplate and lift the plate up from the cover housing.

Replace the filter fleece (see fig. Replacing the filter fleece)

Before assembly, check the state and the correct position of the seals and
the filter fleece.

Now, insert the cover baseplate with the mounted de-aeration tubes in the
cover housing und when doing so, pay attention to the position of the filter
fleece (11).

Next, tighten the cover baseplate with the three screws (13).

Screw the two de-aeration valves (2) into the venting holes (9) and tighten
them with a 13-mm open-jaw wrench.

Screw the antenna (4) onto the grinding jar cover. Schrauben Sie die
Antenne (4) ab.

6.11 Clamping the Grinding jar with the Clamping Ring

’ The wireless grinding jar cover cannot be used in the PM 200.
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>

The wireless grinding jar cover cannot be used in the PM 200.

Comply with the operating instructions for your ball mill too.

This document only has instructions for the use of the PM GrindControl. Safe
handling of the planetary ball mill is a precondition for the use of the PM
GrindControl.

> B
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Fig. 46::Position of the clamping ring

For the measurement of the grinding jar’s inner pressure to work correctly, the
grinding jar cover must be braced with the clamping ring, which is included in the
scope of supply.

. The spacer (26) must be between the cover lug (21) and the clamping ring.

. When bracing it, it is necessary to align one of the cover lugs (21) with the
labelling areas (24) in order to ensure that the catching hole (27) in the
grinding jar can engage with the catching pin (23).

Risk of the grinding jar being hurled out!

Make sure before starting the machine that the grinding jar is clamped in position.

With due consideration to the degree of risk presented by the particular material
you are grinding, please take appropriate precautions to ensure that there will not
be any danger to people.
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Risk of burning your hands.

It is essential to wear safety gloves when removing or opening the heated grinding
jar.

6.12 Wet Grinding with Highly Flammable Materials

Wet grinding using easily inflammable materials is admissible providing certain
precautions are taken.

When using highly flammable materials as grinding aids, such as for example,
hexane, isopropanol, ethanol, benzene and suchlike, it must be assumed that the
inside of the grinding jar is classifiable as zone 0 with a continually present
explosive mixture.

It must therefore be ensured that the explosive vapours that arise during the
grinding process, in particular because of the heating that occurs then, cannot
escape from the clamped-in grinding jars or reach areas that contain the required
ignition energy.

We therefore urgently recommend that before using such solvents the operator
(employer) of the planetary ball mill should assess the existing hazards and draw
up a coherent explosion protection policy, taking account of local conditions and, if

necessary, providing written definitions of supplementary organisational measures
in an explosion protection document.

In the EU, this procedure is regulated by articles 118 and 118a of EC Directive
89/391/EEC.

Please observe comparable regulations in countries outside the EU.
For this purpose, assume the following prerequisites for the PM100/200:

. Only type “C” grinding jars are admissible for wet grinding with highly
flammable materials.

. When selecting solvents, the O-rings’ resistance must be taken into account.
The following are therefore permissible: alcohol (apart from methanol and
ethanol), isopropanol, diisopropylether.

. Once the grinding jars have been filled, seal them with the clamping rings
included in the scope of supply.

Tighten the camping screws on the clamping ring securely!

Tighten the clamping screws on the clamping ring securely.
Only then are inside pressures up to a max. 5.5 bar permissible.

. Please note that depending on the size of the grinding jar, the ball filling,
speed and grinding time, the grinding jar can by all means reach a
temperature of over 100°C.

. The PM100 and PM200 are fitted with a fan which extracts only directly from
the grinding chamber. The extraction volume per hour is more than 20 times
the volume of the grinding chamber. The fan has a standstill monitor with an
acoustic alarm.

. The air stream produced by the fan during grinding must be conducted to an
extractor.
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. Before removing the grinding bowl, make sure that the clamping ring is
sitting securely.

. Only remove the grinding bowl! with the closing device. Before opening it, let
it cool down and make sure it is in a safe position (suction equipment).«

7 Telegesis (ZigBee) USB stick

Do not pull the Telegesis (ZigBee) USB Stick out of the USB port as long as
the PM GrindControl software is active.

7.1 System Requirements

Your PC must meet the following technical requirements to allow the use of the
Telegesis (ZigBee) USB stick:

- Windows XP or Windows Vista
— USB 2.0 (1.1)

7.2 Technical Data
Frequency band: 2.4GHz ISM band

Transmission rate: 250kbit/s over the air data rate — NB: actual usable data
throughput with ZigBee® is about 20kbps

Transmission power: Typically 17dBm (50mW) output power

Damping: High sensitivity of -97dBm Typ (at 1% packet error rate)

36



EE'I.E ch Operating Instructions for Powerline 5 LCD

8 Operating Instructions for Powerline 5 LCD

' Charge new batteries completely before using them for the first time. This
extends the service life of your batteries.

—— CHARGING STATUS / LADEZUSTAHD

X % x &

)
L 5% 50% 75% 100%

——

Fig. New batteries must be charged completely first before they are inserted.

Fig. 47: Inserting the charging adapter
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Read the operating instructions carefully before commissioning the
appliance!

8.1 Safety Instructions

Warning — General dangers!
» The appliance may only be operated in closed, dry rooms.

* To eliminate the danger of fire or of an electrical shock, the appliance must be
protected from moisture and rain.

* Please ensure that the ventilation slits are free so that the appliance can work
perfectly.

» Do not operate the appliance if the mains plug or housing is damaged.
* Do not open or modify the appliance.

» Have repairs carried out only by an authorized dealer.

» Keep out of reach of children.

* Do not run the appliance unsupervised.

* After use, disconnect the appliance from the mains supply.

* Pull out the mains plug before doing any cleaning or maintenance work.

8.2 Using the Charger

Only the special batteries supplied by Retsch may be used in the
POWERLINE 5 LCD charger!

CAUTION:

is a risk of explosion with other batteries!

Alkaline batteries or other primary batteries may not be charged under any

circumstances

Never use force to open storage batteries or other kinds of batteries and

never throw them into a fire.

8.3 Overview of the Charger Functioning

38

- Separate charging procedures for every battery

- Automatic commencement of charging once contact is established;

- Microcontroller-controlled charging and monitoring of the charging status

- Automatic switching over to trickle charging

- Pre-discharge possible;

[Hetsch’

Insert only Nickel/Cadmium or Nickel/Metal hydride storage batteries; there
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- Status indication with indicator lamps and LCD

- Battery fault detection — faulty batteries are picked out and displayed.—
8.3.1 Indicator Lamps for Batteries (1)

Indicator glows red: charging
Indicator flashing red: battery faulty
Indicator glows yellow: discharging

Indicator glows green: battery charged / pulse retention charging
8.3.2 LCD Display (3)

In addition to the indicator lamps, the display gives information on the charging
state, the operating mode and the status of the inserted batteries (see drawing).
The operating mode (charging or discharging) is displayed alternatively.

Thereafter, for approx. 3 seconds, the charging status is displayed in 25 % steps.
“OK" indicates the end of charging / trickle charging; “BAD* indicates a faulty
battery.

8.3.3 Discharge key (4)

Pressing the discharge key (PRESS) for approx. 3 seconds starts the discharging
process.

8.4 Commissioning the Charger

Mains Operation:

Connect the power supply plug to the charger. Connect the power supply to the
mains supply.

Charging the special Retsch storage batteries:
The charging starts automatically when one or more batteries are inserted.
To insert the storage batteries, it is first necessary to insert the charging adapter:

Press the contact bridge (5) down and insert the cell into the charging
compartment.

The storage batteries do not have to be inserted at the same time because the
batteries charge independently of each other.

It is normal for the batteries to become hot while charging. Once charging is
complete, the batteries are supplied with trickle charging and can remain in the
charger till they are used.

Discharging:

To discharge the storage batteries, simply press the PRESS button (4) for approx.
3 seconds. Once the storage batteries have finished discharging, the appliance
automatically switches over to charging. It is possible to discharge some batteries
and simultaneously charge other batteries. When batteries are inserted into
unoccupied charging compartments after activated discharging, they are charged
and not discharged!

8.5 Maintenance and Care of the Charger
Pull out the mains plug before doing any maintenance and cleaning work. To

ensure that the appliance will work without problems, please keep the contacts in
the charging compartment free of dirt. Clean the appliance only with a dry cloth.
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8.6 Environment Notice

By using rechargeable batteries and chargers, you can protect the environment
and save at the same time. Batteries should not be disposed of with the household
waste. Bring used batteries to your dealer or to the battery collection point.
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LCD-Display fiir Rundzellen :
CHARGING / LADEN
.
>>> >>> >>> (s (Il
L . L
L] | L] L] =
a
S>> 35> S>> approx.. dsec >>> S>> >>> E
=
—— (HARGING STATUS / LADEZUSTAND =
_______ - ||| ————
- - I
L] — ] - = =
25% 50% 75% 00% = =
<
2
DISCHARGING / ENTLADEN =]
=
] - - . =
>>> S>> (Ml s = >>> = =
L]
S>> 33> 55> approx./ea. dsec S>> 55> >>>
BATTERY STATUS / AKKUZUSTAND
e *E
L
BAD Faulty cell / B Ready /
Akku defekt” Akku geladen”
Fig. 20: LCD display, charger
- : "\
Il |
-© = ‘
240 = \y |
e o = | |
Blucl /
e |/
CHARGING TIMES (WHEN BATTERIES EMPTY)
LADEZEITEN (BEI LEEREN AKKUS)
CHARGING CURRENT | CHARGING TIME per 100 mAh | CUT-OFF
TYPE/TYP | | \DESTROM (md) | LADEZEI pro 100 mih ABSCHALTUNG
MICRO AAA 500 approx./ca. 15 min avtomatisch / automatic
MIGNON A& 1000 approx./ca. 7,5 min avtomatisch / automatic
BABY C 1000 approx./ca. 7,5 min aulomafisch / automatic
MONO D 1000 approx./ca. 7,5 min aulomafisch / automatic
9V BLOCK 15 approx./ca. 480 min (8h) manval/manvell

Fig. 21: Charger function elements and charging times
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